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Contacting the District Service Management Group 

 
You can access the District Service Management group’s website at http://dsmp.in.dc.gov. From this 
website, you can obtain information about the District Service Management products and services. 
 

District of Columbia 
 
Address:  Office of the Chief Technology Officer 
       District Service Management Program 
     441 4th Street, NW Suite 1045S 
       Washington, DC 20001 
 
Telephone: 202-727-4063 
 

If you have comments or suggestions about this documentation, contact the District Service 
Management Group Customer Care by email at DSMCustomerCareTeam@dc.gov. 
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1 Scope and Audience 
This document will give you an introduction to the life cycle of a basic DCHR Service Desk record and 
get you up to speed quickly.  
 
This document is for you if you intend to create and resolve DCHR Service Desk records within the 
application as a supplemental aid to application training. This document does not replace training, and 
does not cover all facets of the DCHR Service Desk application.  

2 Getting Started 

2.1 Logging In 
Follow these steps to log into the DCHR application:  
 

1. Start the Remedy client tool to access the login dialog. If you have not been given a User Name, 
contact DSM at DSMCustomerCareTeam@dc.gov 

2. Enter your User Name and Password and then click the OK button.  
 
Remedy User Name = Email ID 
Remedy Password =  Network ID 

 
(Figure 1) Your User Name will be everything before the @ sign of your email address. For 
example, jim.jones2@dc.gov would have the User Name jim.jones2. Your Password 
will be the same one that you use for network access. (Figure 2) Your console displays when 
you log in. (Figure 3)  

 

 
 

Figure 1 – Log in to Remedy with your Email ID (everything before the @ sign) 
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Figure 2 - Log into Remedy with the same password you use for network access 
 
 

 
Figure 3 – Your Console screen 

2.2 Create a Shortcut to your Desktop for DCHR Answers 
1. Select File>Open>Object List from the menu bar displayed at the top of your screen (Figure 

4) to open the Object List. This list displays the forms and applications available on the 
Remedy Server. 
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Figure 4 – Opening the Object List 
 

2. Click the Find tab and then type dchr for your search term. Click the Find button on the right.  
DCHR Answers will display as one of your results. Make sure the Type field displays 
Application. (Figure 5) 

3. Right click on DCHR Answers and select Create Shortcut from the menu. (Figure 5) The 
Save a Shortcut dialog displays. (Figure 6) 

 

 
 

Figure 5 – Creating a shortcut 
 

4. Make sure that you’re saving your shortcut to your desktop (Figure 6). Enter DCHR Service 
Desk 7.1 for the File name, and then click Save. 
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Figure 6 – Save your shortcut to your Desktop 
 

5. The shortcut icon will display on your desktop. (Figure 7) 
 

 
 

Figure 7 – DCHR Answers desktop icon 
 

2.3 Create a Shortcut for the Old Remedy 
1. Click on Tools > Login. The Login dialog displays. (Figure 8) 
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Figure 8 – Accessing your Accounts 
 

2. Click the Accounts button, and then use the Add button to add remedy.in.dc.gov to the server 
list in the Account dialog.  

3. Place an x next to the server you are currently using (Figure 9), and then click OK. 
 

 
 

Figure 9 - Your Account dialog 
 

4. Click OK for the Login dialog. The previous version of Remedy displays. (Figure 10) 
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Figure10 – Remedy 5.5 
 

5. Click the Support Console link to access the IT Service Support Console.  
6. Select File > Open > Object List from the menu. The Object List displays.  
7. Click the Find tab, enter remedy support for your search term, and then click the Find 

button.  
8. Right click on the Remedy Support application, and create a shortcut to your desktop. 
9. Rename the shortcut as Old Remedy. 
Insert the image of the “old remedy” icon here. 
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3 Working with Requests 

3.1 The Console View 
You may click on the Console View links to the left of the screen to change the data displayed on your 
console, and the General Functions links for quick access to the various functions within the 
application.  
 
The options in your Console View are: 

 
• Show All Open – Displays all open tickets for your group(s) 
• Show Unassigned – Displays all unassigned tickets in your group(s) 
• Assigned To Me – Displays all tickets assigned to your login ID 
• Show My Open – Displays all open tickets assigned to your login ID and unassigned 

tickets assigned to your group(s) 
 
The options in your General Functions are: 
 

• New Request – Creates a new DCHR request 
• Search Request – Launches your search screen 
• My Profile – Allows you to update your contact information 
• Reports – Launches reports for DCHR requests 
• Survey – Displays your user surveys (This link is only viewable to managers who have 

been given access to survey results) 
 

 
 

Figure 11 – Your Console 
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3.2 Your Search Criteria 
You can adjust the view of your console by selecting different search criteria. You may select an 
alternate Status, Group or Requester Type from the drop down lists. Click the Search button to display 
your results. 
 

 
 

Figure 12 – Search criteria for your console 

3.3 Adding Notes to a Request 
You may add a note to a request from your console. (Figure 13) As you click on the requests in your 
console, its information is displayed in the fields below. Enter a note in your Notes field, and then click 
the Add Notes To Request button to add it to the Work Info History list of your request. The Work 
Info History is discussed in section 4.2. 
 

 
 

Figure 13 – Click this button to add your notes to a request 
 

3.4 Submit a New Request 
1. To create a new request from the Support Console, click the General Functions link, if 

necessary, and then click the New Request link (Figure 14) to display the Incident Request 
Information form (Figure 15). You may also click on the Create button at the bottom of the 
screen. 
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Figure 14 – New Request link 

 

Figure 15 – Incident Request Information form 

2. You may use the Process Flow Status section at the top of this form to move through the 
process quickly. If you are using the system for the first time, it is best for you to understand the 
whole process before using that option. 

3. Search for or create the requester: You should always verify the customer’s first name, last 
name and spelling by phone or in person. If the customer is sending in an email request, you 
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can enter their first name and last name in the respective fields, and press Enter on your 
keyboard to retrieve their information. If their information does not display, use the steps 
outlined below to search or create a record. 

• To search for the requester, enter the last name of the requester in the Last Name field, 
and then click Search. The People Search form displays.  

• Click on the correct requester’s name from the resulting list, and then click the Select 
button of the People Search form. The requester’s information will display on your new 
request.  

• Choose a Requester Type from the list directly above the First Name field. Requester 
Type will default to “Employee.” 

• You may enter more information at the top of the People Search form and click the 
Search button for more results. (Figure 16)  

• You may enter parts of the first and last name and press Enter to retrieve your results. 
 

 
Figure 16 –Choose the requester from the resulting list or enter new search criteria and click the Search button. 

 
• Create the requester profile if they do not appear in your search results. Click the Create 

button on the Incident Request Information form (Figure 15) to start the People form. 
(Figure 17)  
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Figure 17 – The People form  

 
• Fill in as much of the requester’s information as you can in the People form. The fields 

in bold print are required fields. The requester’s information will not be saved unless the 
required fields are filled in. When you click the Save button, your new requester 
information will display in the Requester Information area of your new request. 

• Include an email address whenever possible. That way the user will receive notifications 
by email as well as the customer satisfaction survey upon resolution of their request. 

• For current employees, choose a Site from the list. The Site will be determined based by 
the Organization and Department you have selected. For external customers, include the 
street address, state, city, and zip code whenever possible using the appropriate fields. 

 
4. The following information will summarize the request, and route the request to the appropriate 

group.  
• Summary – The Summary field contains a brief statement regarding the request. This 

field will display in your console view when you log in, so make it easy to understand at 
a glance. 

• Description – The Description field should contain more details of the request. 
• Category - The Category field is the broadest categorization of the request. For 

example, request categories could include Audits, Employee Records or Benefits.  
• Type - The Type field is determined by the value you selected for the Category field. 

The Type field identifies the request with more precision. For example, if you choose 
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Benefits for the Category, your request type might be Dental, Health Benefits, or 
Vision. 

• Item - The Item field is determined by the values you selected for the Category and 
Type fields. The Item field is the action to be performed on your Category and Type. 
For example, the items could include Didn’t Receive, Requesting, or Where to Mail. 

 
5. Choose a Group Name from the drop down list. (Figure 18) The groups that appear in the drop 

down list are determined by the Category, Type, and Item you have selected. 
 

 
 

Figure 18 – Choose a Group Name from the list 

6. Choose your name from the Individual drop down list if you are going to work on the request. 
If you are not going to work on the request, do not choose an Individual. An Individual will be 
selected by the group receiving the request. 

7. Choose a Priority from the drop down list. Your choices are Low, Medium, High and Urgent. 
The priority dictates the time for your service level agreements (SLAs). The priority will default 
to Medium. 

8. The Status is set to New when you create a request. The Status value will change 
automatically based on your progress with the request. You may also select a Status at any time 
appropriate during the life cycle of a request. 

9. Click on the Activity tab of your new request. (Figure 19) 
10. Click on the down arrow of the Source field. Choose the source that best describes the way 

your request came in, and, if necessary, choose a Call Type from the list directly below. 
(Figure 20)   
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11. If your request came in via Tele Text Type, be sure to select Tele Text Type under Call Type. 
If the Call Type is Language Translator, you must also choose the Language from the drop 
down list. If your call was neither of these options, you may leave the field blank. (Figure 21) 

 

  
Figure 19 – Activity tab 
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Figure 20 – Choose a Source and Call Type if necessary 

 

 

Figure 21 – Choose a Language if your requester uses an interpreter 

12. If you would like to add attachments to your request, right click anywhere in the Attachments 
area, and select Add from the pop up menu. (Figure 21) Select your document from the 
resulting list and then click Open. Your attachment will display in the list.  
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Figure 21 – Adding an attachment 

13. Click on the Work Info tab to complete your new request. The details are outlined below.  

3.5 Update the Work Info 
This tab allows you to enter new work items and view existing work items. (Figure 22) Although you 
can resolve a ticket without adding items to the Work Info tab, it’s very important to add at least some 
details to your request for future reference. 
 

1. Select a Work Info Type from the drop down list. 
2. Select a Source from the drop down list. 
3. Type in your Work Summary. You may also click the box to the right of the Work Summary 

field for more writing space. The extra space makes it easier to write, or to paste an email 
message.  

4. You may right click in the Attachment area, and then select a document to add it to your work 
information. 

5. Click the Add to Work Info History button when your information is complete. A 
confirmation message will display, and your new entry will be listed in the Work Info History 
list. Please keep in mind that once you add this work info to the work log, the information 
becomes read-only and you will not be allowed to modify the entry. 

6. You may view a single entry by double clicking on it from the Work Info History list, or by 
selecting it and clicking the View button. 

7. Click on the View Entire Worklog link to view all entries.  
8. Click the Save button after updating the Work Info tab. When you click the Save button, the 

request becomes ready for you or any other user to modify and resolve. 
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Figure 22 – Adding your entry to the Work Info History 

3.6 Service Level Agreements  
This tab contains the service level agreements (SLAs) for your request. (Figure 23) The Hours 
correspond to the Priority of your request. For example, an Urgent priority request will have a shorter 
time to resolve than a Low priority request. Check your SLA tab to see how much time is remaining on 
the SLA.  
 
In the example below, there are 2 SLAs—one for response (the time you have to assign an individual to 
the ticket) and one for resolve (the time you have for setting the status of the ticket to Resolve). The 
Response time has been met, and the Resolution time has not yet been reached. When you click on an 
SLA in the top of this form, the corresponding Action will display in the second window, Actions For 
SLA. For the example below, you would have until 8/14/2008 8:54:37 AM to resolve the request. 
 

 
Figure 23 – Your SLA tab 
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4 Searching Requests 

4.1 Quick Search 
The top of your Support Console contains three fields that you can use for a search; Status, My 
Groups and Requester Type. This search is only for your Console view. Select your criteria and then 
click the Search button to display your results. (Figure 24) 
 

 
 

Figure 24 – Use these fields to change your Console view 

4.2 Detailed Search 
 

1. Click the Search Request link from your Support Console (Figure 25). The Incident Request 
Information search form displays. (Figure 26) 

 

 
Figure 25 – Search Request link 
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Figure 26 – The Incident Request Information search form  

2. Enter your search criteria and then click the Search icon in the upper right corner. Your search 
results will display as a list. 

5 Modifying Requests 

5.1 Request Status 
Service requests can assume any or all of six status choices over the course of their “lives”.  As you 
modify a request, it is important that you update the status accordingly. The following table describes 
each status. 
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Status Description

New This is the default status for a new ticket.

Assigned This is the status immediately upon submission or transfer of a ticket to 
a support individual and/or group.  A ticket in this state has had no work 
performed on it beyond attempts at resolution (when appropriate). 

Work-in-Progress 
(“WIP”) 

Once a support individual and/or group has acknowledged the ticket and 
contacted the customer, it is considered work-in-progress, and you must 
manually change the status to Work-in-Progress.  Compare to 
“Pending.” 

Pending A ticket in this state has had all the work done that support personnel 
can perform, and further work is dependent on an outside entity.  
Examples are that additional information is needed from the user, or 
action or materials are needed from an outside vendor. When you 
change the Status to Pending, you must also select a reason in the 
Pending list directly below the Status field. A Pending status stops the 
Service Level Agreement clock. Once the pending reason is reached, 
change the Status as needed, and clear the Pending reason field below 
the Status field. 

Resolved When you have completed a ticket, you must change the status to 
Resolved.  Such a ticket is awaiting follow-up with the customer to 
verify that the problem has, in fact, been resolved.  Contrary to one that 
has been Closed, a ticket can move from Resolved to a previous state.  
The system will automatically close any tickets that remain in a 
“Resolved” state for more than 3 business days. 

Closed A ticket is Closed in either of two situations: the user confirms that the 
problem has in fact been resolved; or after the passing of 3 business days 
with no contact from the user. Once marked Closed, a ticket cannot be 
re-opened or otherwise re-designated. 

 

5.2 Process Flow Status 
The Process Flow Status diagram at the top of your screen (Figure 27) can helps you visualize the full 
life cycle of your request. The system will allow you to close a request with all required fields 
completed and an Individual selected from the list. However, it is best to enter appropriate information 
on the Activity and Work Info tabs of your requests for reporting reasons. 

5.3 Changing a Category, Type or Item 
Follow these steps to change the Category, Type and/or Item of a request. 

1. Open your request. (Figure 27) 
2. Click the down arrow for the Category field, and select another category from the list.  
3. Change the Type and Item fields as needed.  
4. Choose a different Group and Individual if necessary, and then click Save. 
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Figure 27 – Category, Type and Item fields 

5.4 Transferring a Request Outside of the DCHR Service Desk System 
When you transfer a request to a service desk outside of the DCHR Service Desk System, your DCHR 
request is closed, and a new request is created for the service desk receiving the transfer. Only 
individuals in certain groups have access to perform a transfer outside of DCHR. Follow these steps to 
transfer an existing request out of DCHR. 
 

1. Open your request. 
2. Click on the Transfer link from the Quick Links area of the support console. (Figure 28) A 

system note displays. 
3. It’s important to read the system note if this is your first time transferring a request. Click OK if 

you agree with the system note. The Transfer Case dialog displays. (Figure 29) Service 
requests are referred to as cases within the software. 

4. Select the desired Routing Group from the list. 
5. Update the Summary and Description if necessary. Remove any and all sensitive or 

confidential information from these fields. 
6. Enter a Transfer Reason, and then click the Case Transfer button. Click I Agree in the 

resulting notification dialog. 
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7. Text in red print at the upper right corner of your ticket will indicate that the request is 
transferred. 

8. This request will automatically close and you will not be able to modify it. You will receive a 
notification from the Outside Service Desk when the request you transferred has been resolved. 

 

 
Figure 28 – The Transfer link 

 

Figure 29 – The Transfer Case dialog 

6 Resolving Requests 
You can resolve a request when all conditions are met for the requester. Follow these steps to resolve 
your request. 
 

1. Open your request. 
2. Select Resolved from the Status list. 
3. Click on the Work Info tab. 
4. Select Resolution for the Work Info Type.  
5. Select a Source. 
6. Type in your details in the Work Summary field, and then click the Add to Work Info 

History button at the bottom of the form. 
7. Click Save. 

 
If the requester’s email address is accurately stored in his/her profile, they will receive notification that 
his/her ticket has been resolved. The ticket will remain in a resolved status for 3 days. If the ticket is 
not re-opened it will automatically close at the end of 3 days. Tickets moved to Closed status cannot be 
reopened. 
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Figure 30 – Resolving a case 

7 Email System 
You may use the Email System to correspond with internal as well as external customers. 
 

1. Open a request. 
2. Select Functions if necessary, and then Email System from your console. (Figure 31) The 

Email System displays. (Figure 32) 
 

 
 

Figure 31 – Email System link 
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Figure 32 – Email System 

 
3. To search for an email address, select a Company from the drop down list. 
4. Enter a First Name, Last Name or Phone Number, and then press Enter on your keyboard. 

The names matching your search will display in the list. 
5. Select the name of the person you would like to email from the list, and their address will 

display in the Email Information section below. 
6. If you already know the email address of the person you are writing, you may enter it in the 

Internet E-Mail field. 
7. Enter a Subject or accept the default. 
8. Type in your message. You may use the Status, Summary, Details and Resolution buttons to 

the right to paste their respective information directly into your message body. 
9. If you would like to include an attachment, right click in the Email Attachment list to select a 

file. 
10. You may also click on the Email Log tab to view past email correspondence regarding your 

ticket. 
11. Click the Send Email Now button to send the message. 

 


